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1. INTRODUCTION TO MINNOW 2.0

The Minnow 2.0 logger is a high accuracy, water
resistant, compact, temperature and humidity data
logger. The logger features a compact LCD display. The
logger comes with a free Windows and MAC application.

This user guide provides basic information about how to
use the logger and Windows/MAC applications. Both the
logger and the applications have been designed to be
intuitive so that you will be up and running with the
logger in a matter of minutes.

The Minnow 2.0 comes in two versions; Minnow 2.0T is
a temperature only version and Minnow 2.0TH is a
temperature and humidity logger. This user guide
applies for both versions.
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Figure 1: Senonics Minnow 2.0
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3.  USING MINNOW 2.0

Minnow 2.0 logger includes two buttons:

START button:

When configured for "Button Press" logger start, this
button starts and stops logging. In other
configurations, this button is inactive.

DISPLAY button:

This button allows the user to cycle through all LCD
views.

Status LED Alarm LED
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Figure 2: Buttons, LEDs and LCD

Minnow 2.0 includes two LEDs:

|
status LED: O

When the logger starts logging then this LED pulses
green once for 1 second.

When logging this LED flashes green for 7
milliseconds and off for 6 seconds.

When the logger stops then this LED pulses red for
1 second then off.

If the logger becomes full this LED flashes red for 7
milliseconds and off for 6 seconds.
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N
Alarm LED: ®

When a temperature and/or humidity alarm is
triggered this LED flashes red for 7 milliseconds and
off for 6 seconds.

A number of display screens can be stepped through by
pressing the "display" button.

The current screen shows current temperature and
humidity.

= 35.0%
2H.3c-

CUR

A further screen shows the maximum readings during a
logging period.

- 392+
£3.c09e

The third screen shows the minimum readings during a

logging period.
m 10.9%

19.4b.

There is also a screen to show the average temperature
and humidity during logging (from last configuration).

EED
.60
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A screen shows upper alarm settings.

OO0
000
L

ALMH

A further screen shows the lower alarm settings.

om  10.0%

. H]'DD

When the logger is logging the star-like logging
indicator * is displayed.

e J5.94
ST T
cH.ac

CUR

When alarms has been triggered, the alarm
indication © is displayed.

359+
2H.4c-

CUR
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4. PC APPLICATION

Your logger may be controlled from a Windows PC or Mac

from USB using a simple application.

4.1. Senonics GUI Main Screen

The Senonics GUI includes a configuration pane, a
graphical pane and a spreadsheet pane. Included also is

a connection indication to signify connection or

otherwise of a Senonics logger.

m Senonics PC Application (1.2.3)
File View Export Options Language Text Help

Logger Minnow 2.0TH (Temperature & Humidity)
Device ID
pC Tme
Logger Tme
Logong Start

Logging Interval 30 secs (max 22 da v
L
Temperature

Alarm Threshold (High)
Alarm Threshold (Low)

Humidity
Alarm Threshold (High)
Alarm Threshold (Low)
Status

Fimicare Revison
Battery Level B 5

Info:
Draw box to zoom in
Right click to zoom out

Configuration Pane

Configure Logger Read Data

Temperature
Humidity
Dew Point

gt

2018.02.02018.02.02018.02.02018.02.02018.02.08018.02.02018.02.08018.02.02018.02.02018.02.09

2.1
‘ 0% 16:31:12 06:21:12 20:11:42 10:01:42 23:52:12 13:42:42 03:32:42 17:23:12 07:13:12 21:03:42
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Figure 3: Senonics GUI
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Connection
Indication E]

DateTime Temp Humidity DewPt ~
2018.02.10 10:31:42 2274 C 3066 % 457C
2018.02.10 10:3212  2271C 3067 % 456C
2018.02.10 10:3242 22.71C 30.66 % 455C
2018.02.10 10:33:12  22.74C 30.72 % 460C
2018.02.10 10:33:42  22.74C 30.71 % 460C
2018.02.10 10:3412  22.74C 30.79 % 463C
2018.02.10 10:3442 2272C 30.72 % 4.59C
2018.02.10 10:35:12 22.72C 30.72% 459C
2018.02.10 10:35:42 22.72C 30.73 % 460C
2018.02.10 10:3&:12  22.74C 30.82 % 465C
2018.02.10 10:36:42  22.74C 30.88 % 467C
2018.02.10 10:37:12  22.74C 30.82 % 465C
2018.02.10 10:37.42  22.75C 30.79 % 465C
2018.02.10 10:3&:12  22.74C 30.92 % 470C
2018.02.10 10:38:42 22.75C 30.82 % 466C
2018.02.10 10:3%:12  22.75C 3088 % 469C
2018.02.10 10:3%:42 22.78C 3097 % 476C
2018.02.10 10:40:12  22.76C 3093 % 4nc
2018.02.10 10:40:42 22.75C 3091 % 470C
2018.02.10 10:41:12 2276 C 30.84 % 468C
2018.02.10 10:41:42  22.75C 30.94 % 472C
2018.02.10 10:4212  22.78C 30.87 % 4mc

18,07 A s anne o a7
s Spreadsheet Pane ..¢
2018.02.10 10:43:42  22.78C 3093 % 473C
2018.02.10 10:44:12  22.79C 30.93 % 475C
2018.02.10 10:44:42 22.75C 30.86 % 468 C
2018.02.10 10:45:12  22.78C 3091 % 473C
2018.02.10 10:45:42 22.79C 3091 % 474C
2018.02.10 10:46:12  22.81C 3093 % 476 C
2018.02.10 10:46:42  22.81C 3093 % 476 C
2018.02.10 10:47:12  22.81C 30.99 % 479C
2018.02.10 10:47:42  22.82C 30.95 % 478C
2018.02.10 10:4&12  22.79C 30.88 % 473C
2018.02.10 10:48:42  22.79C 30.88 % 473 ¢C
2018.02.10 10:4%12  22.79C 30.85 % 471C
2018.02.10 10:4%:42  22.82C 30.87 % 475C
2018.02.10 10:50:12  22.82C 30.81 % 472C
2018.02.10 10:50:42  22.82C 30.84 % 473C
2018.02.10 10:51:12 22.82C 30.72 % 467C v
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4.2. Configuring a Logger

Configuration of the logger is performed with the logger Wait for the logger to finish configuration (indicated by
connected. the busy indication disappearing).

Update all settings on the configuration pane such as _
logger name, logger start option (on disconnection, A Logger BUS_V
button press or at specified time), logging interval (1

second, 10 seconds, 30 seconds, 1 minute, 10 minutes,

30 minutes or 1 hour), temperature and humidity logging
enables, temperature and humidity alarm levels.

When complete press the configure button.

X Configure

¥ Senanics PC Application (12.3) — m] X

File View Export Options Language Tedt Help

A Logger Busy E]
Temperature ~
Logger Minnow 2.0TH (Temperature & Humidity) Hurr:ll:jrty DateTime Temp Humidity — DewPt
Device ID Room#24 Dew Point il 16562  2018.02.10 10:31:42  22.74C 30.66 % 457C

16563  2018.02.10 10:32:12 271C 3067 % 456 C
16564 2018.0210 10:3242  2271C 30.66 % 435C
16565 2018.02.10 10:33:12 2274C 30.72% 460 C
16566 2018.02.10 10:33:42  2274C 30.71% 460 C
16567  2018.02.10 10:34:12 2274C 30.79 % 463 C
16568 2018.02.10 10:34:42 2720 3072% 439C

PC Time
Logger Time 2018.03.16 21:47:05

Logging Start Button Press

Logaing Interval | 30 secs (max 22 da ~

<D 16560 20120210 10:35:12  2272C  3072%  459C
16570 20180210 103542 2272C | 3073%  A60C

UEILEETS 16571 20180210 103612 2274C  3082%  465C
Alarm Threshold (High) 16572 20180210 10:36:42  2274C  3088%  467C

Abarm Threshold (Low) 16573 20120210 103712 2274C | 3082%  485C

16574 20180210 103742 2275C | 3079%  AB5C

Hurmidity ; 16575 20120210 103312 2274C | 3082%  470C
T ¥, Comiguration x 16576 20180210 103842 2275C | 3082%  A66C

16577 20180210 10:3912  2275C | 3088%  469C

Alarm Threshold (Low) This will erase all data on device. 16578 20120210 10:3942  2278C | 3087%  4T6C

o Are you sure you want to configure? 16579  2018.02.10 10:40:12  22.76C 3093% a72c

16580 2018.02.10 10:40:42  2273C 3091% 470C

Firmware Revision 20020 III 0 16581 2018.02.10 10:41:12 2276 C 3084 % 468 C

Battery Level | BE 16502 20120210 10:41:42  2275C  084%  472C
16583  2018.02.10 10:42:12 27mcC 30.87 % 4nc

16584 2018.02.10 10:42:42 278C 3091 % 473C
16585 2018.02.10 10:43:12 2278C 30.87 % 471C
16586 2018.02.10 10:43:42 2278C 3093 % 473C
16587 2018.0210 1044712  2273C 3093 % 475¢C
16588 2018.02.10 10:44:42 2275C 30.86 % 468 C
16589 2018.02.10 104512  2278C 3091 % 473C
16590 2018.02.10 10:45:42 2279C 3091 % 474C
16591 2018.02.10 10:46:12 281C 3093 % 476 C
16592 2018.02.10 10:46:42 2281C 3093 % 476 C
16593 2018.02.10 10:47:12 2281C 3099 % 479C
16594 2018.02.10 104742  2282C 3095 % 473 C
16595  2018.02.10 10:48:12 2279C 30.88 % 473C
16596 2018.02.10 104842  2273C 30.88 % 473C
16597  2018.02.10 10:4%:12 2279C 3085 % 4nc
16598 2018.02.10 10:43:42 2282C 3087 % 473C
16599  2018.02.10 10:50:12 228C 3081 % 472¢C
16600 2018.02.10 10:50:42 2282C 3084 % 473C
16601 2018.0210 10:51:12 2282C 3072 % 467C v

u
=

Info:
Draw box to zoom in
Right click to zoom out

K e [

I 0%

Figure 4: Configuration
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4.3. Retrieving Logger Data

Data can be retrieved from the logger by connecting to

the logger and then pressing the read button at the

bottom left of the GUI. Both the device configuration and

logged data will become uploaded and viewable in the
configuration, graphical and spreadsheet views.

¥ sencnics PC Application (1.2.3)
File View Eport Options Langusge Ted Help

Logger Minnow 2.0TH (Temperature & Humidity)
Device ID Room#24

PC Time 2018.03.16 21:45:16

Logger Time 2018.03.16 21:46:29

Logging Start Button Press

Logging Interval 30 secs (max 22 da ¥

LCD
Temperature
Alarm Threshold (High)
Alarm Threshold (Low)
Humidity
Alarm Threshold (High)
Alarm Threshold (Low)
Status

Firmware Revision 20020
T e

w
=

Info:
Draw box to zoom in
Right click to zoom out

T
ENEI

Temperature
Humidity
Dew Point

Figure 5: Retrieving Logger Data

4.4. Saving and Opening CSV

Logger data and configuration may be exported to file in

Comma Separated Value (CSV) format. This format can

be edited by third party software such as Microsoft Excel

or read back into the Logger PC application at a later

point.

Revision 1.0.5
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DateTime Temp  Humidity =~ DewPt A
20180210 103142 2274C | 3066% | 457C
20180210 103212 2271C  3067% | 456C
20180210 103242 2271C  3086%  455C
20120210 103312 2274C  3072%  460C
20180210 103342 2274C  3071%  460C
20180210 10:3412  2274C  3079%  463C
20180210 103442 272C | 072% | 459C
20180210 103512 2272C  3072% | 459C
20180210 103542 2272C | 073% | 460C
20180210 103612 2274C  3082%  465C
20180210 103642  2274C  3088%  467C
20120210 10:37:12  2274C  30.82%  465C
20180210 103742 2275C | 3079%  465C
20180210 103812 2274C  3082%  470C
20180210 103842 2275C  3082%  466C
20180210 10:3%12  2275C  3088%  469C
20180210 103042 2278C  3087%  476C
20180210 104012 2276C  3083% | 472C
20180210 104042 2275C  081%  470C
20180210 104112 2276C  3084%  468C
20180210 104142 2275C | 3094%  472C
20180210 104212 2278C  3087%  4T7IC
20180210 104242 2278C  3081%  4TC
20180210 104312 2278C  3087%  47IC
20180210 104342 2278C  3083%  473C
20180210 104412 2279C | 3083% | 475C
20180210 104442 2275C  3086%  468C
20180210 104512 2278C  3081% | 473C
20180210 104542 2273C | 3091% | 4TAC
20180210 104612 2281C  3093% | 476C
20120210 1045:42  2281C  3083%  4T6C
20120210 104712 2281C  3089%  479C
20180210 104742 2282C  3085%  478C
20180210 104812 2273C  3088%  473C
20180210 104842 2279C  3088%  473C
20180210 104912 2273C  3085%  471C
20180210 104942 2282C  3087% | 475C
20180210 10:50:12  2282C  3081%  472C
20180210 10:50:42  2282C  3084%  4T3C
20180210 105112 | 2282C | 3072% | 467C v

To write a CSV file navigate File>Save CSV.

To read a CSV file back select File>Open CSV, and

then navigate to the CSV file.

Senonics LLC ©
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4.5. Cloning Loggers

For customers that expect to configure multiple loggers You can then connect loggers to your PC. When you
with the same configuration, Senonics offer the clone press "Configure” the new logger is programmed each
feature. time with the same cloned settings.

% I Be aware that the Device ID is not cloned, in order to
First, press the clone icon L=J¥ or navigate preserve the logger identification. At any time, you can

File>Clone Logger. unlock, change settings and then lock again.

You are then presented with two copies of the
configuration pane. Enter your configuration in the left-
most pane. When you are complete press the "Clone
Settings" button. This will copy all settings across to the
right-most pane. When you are satisfied press the "Lock
Settings" tick-box.

¥ senonics PC Application (1.2.3) - m} X
File View Export Options Language Text Help
<& A =
Logger Minnow 2.0TH (Temperature & Humidity}
Logager Time 2018.03.16 21:47:33
Logging Start Button Press - Logging Start Button Press -
Logging Interval | 30 secs (max 22 da = Logging Interval | 30 secs (max 22 da ~
LCD On i LCD On ke
Temperature Temperature
‘Alarm Threshold (High) | disabled A Alarm Threshold (High) disabled -
Alarm Threshold (Low) | disabled - Alarm Threshold (Low) | disabled -
Humidity Humidity
Alarm Threshold (High) | disabled - Alarm Threshold (High) disabled -
Alarm Threshold (Low) | disabled v Alarm Threshold (Low) disabled -
S [ Lock Settings
Firmware Revision 20020
Battery Level - 50%
Clone Settings
Configure
0%
Figure 6: Logger Cloning
Revision 1.0.5 Senonics LLC © 9/13
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4.6. Auto Read to File

Some customers like the ability to be able to connect a ¥ Read and save Options %
logger and automatically download and save data to file.

@ Mone
Select Options>Read and Save Options. ) Auto read on connection

() Auto read and save on connection

You are then presented with three options:
a) to disable auto-reading of the logger (default)

Log Folder | C: [Desktop | I

. . Indude Field:

b) to automatically read the logger data on connection nese fEes | Legger D Up
to the Senonics GUI Date
o the Senonics — —

c) to automatically read the logger data on connection

. Fu #24_20180316_214712.
to the GUI and save to file oo - =

Figure 7: Read and Save Options

In saving to file you can change the order of the date,
time and logger ID as they appear in the file name.

4.7. Opening Excel 4.8. PDF Reports

PDF

. | A

It is possible to press the Excel button or navigate Open a one-page PDF report by pressing the PDF
Export>Open Excel to show the data in Microsoft icon or navigating Export>Save PDF. A PDF is written
Excel. During this process the user needs to select if to summarize the data in the logger by way of statistics
your version of Excel is expecting and "." or "," to and as a graph. The PDF can be written either in US
represent the number decimal point. Letter page size of A4 page size.
This capability assumes that Microsoft excel is installed The user can enter one’s own notes at the footer of the
on your PC. If not, then the option will not work. This PDF. PDFs are written to file and can be opened by any
option is not available on the Mac version of the GUI. standard PDF reader — like Adobe Acrobat.

= Senonics Data Logger Repor

Setup
Loggor Sanorics Minnaw 2 0TH - Roome24
Loggor Stat Sutton s
Leoger Inenval Wsecs

Alams
Temperature Loggng Enatled Humicty Logging Enatied
Temperature Alam (Highi.  nan Humiaty Alarm (High).  nan
Temparature Alam (Highl.  nan Huricly Alarm (High),  nan

Statistics

Hur
Hu

migity Madmum: 43,66 %
‘‘‘‘‘ ity Minimom: 2175 %
ity Aversy 038%

» 5 Temperahre Huricty Dew Paint 50

h | | i

: " ’\fﬁt !‘-‘\\J, ‘.\,«ﬂ‘u\_“ § )

e g E— " B Vah_,«“‘"\,.jlﬁ Y '\.‘ \\‘J»,\ p’f\\“‘r\ "
I ’ IV] LYy

Figure 8: Opening Excel : e

Ec
S
2|
5
8

Figure 9: Writing PDF Reports
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49. External Sensors

Minnow 2.0 is capable of working with an external sensor.

1. Plug your Minnow 2.0 into the PC with the PC application running. The
extension cable will be disconnected.

Select all desired configuration.

Select the type of extension cable you have.
Configure.

Disconnect the logger

Connect the extension cable.

2

The logger will be showing internal (CUR) and external (EXT) readings as one
cycles through the display screens.

- 359
244

39.2%

29.29.

Minnow 2.0T & Minnow 2.0TH
User Guide

m Sencnics PC Application (1.2.3)
File View Export Options Language Text Help

FEAE

Internal

Logger Minnow 2.0TH (Temperature & Humidity)
Device ID

PC Time

Logger Time

Logging Start Button Press =

Logaing Interval | 30 secs (max 22 da ~

Show internal sensc
[ Ext Sensor external sensor dat

Revision 1.0.5
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LCD On =
Extension Cable
Cable Type External T/H Cable 12 ~
None
External T Cable 11
Temperature arna able
Alarm Threshold (High) | disabled -
Alarm Threshold (Low) | disabled -
Humidity (Ext Sensor)
Alarm Threshold (High) | disabled hd
Alrm Threshold (Low) | disabled -
Status
Battery Level 0%
Info:
Draw box to zoom in
Right click to zoom out
.9’ Configure - ‘t Read

0%

Figure 10: External Sensor Configuration

Senonics LLC ©
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When you are ready to download the data:

1. Disconnect the external sensor
2. Connect the logger to the PC

3. Read the logger. Both internal and external data is downloaded.

Senenics PC Application (1.2.3)

File View Export Options Language Tedt Help

[ 1ntemal
[ Ext Sensor

Logger Minnow 2.0TH (Temperature & Humidity)
e 0

Logging Start

Logging Interval

Extension Cable

Temperature (Ext Sensor)
Alarm Threshold (High)
Alarm Thrashold (Low)
Humidity (Ext Sensor)
Alarm Threshold (High)
Alarm Threshold (Low)

Status

L ]
"

Firmware Revision

Battery Level

Info:
Draw box to zoom in
Right click to zoom out

Show internal sensor or
external sensor data

Temperature (Ext)
Humidity (Ext)
Dew Point (Ext)

16368
16369
16370
16371
16572
16573
16574
16575
16576
16577
16578
16579
16580
16581
16582
16583
16584
16385
16386
16587
16588
16589
16390
16591
16592
16593
16594
16595

2180210
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10
2018.02.10

16597

DateTime

3442
10:35:12
10:35:42
10:36:12
10:36:42
10:37:12
10:37:42
10:38:12
10:38:42
10:39:12
10:3%:42
10:40:12
10:40:42
10:41:12
10:41:42
10:42:12
10:42:42
10:43:12
10:43:42
10:44:12
10:44:42
104512
10:45:42
10:46:12
10:46:42
10:47:12
10:47:42
10:48:12
10:48:42
10:4%:12
10:49:42
10:50:12
10:50:42
10:51:12
10:51:42
10:52:12
10:52:42
10:53:12
10:53:42
10:5412

Temp Int
22420

272¢C
272¢C
274C
274¢C
274¢C
275¢C
2274¢C
275¢C
275C
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2278C
2278C
2278C
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275¢C
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279¢C
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2282¢
282¢C
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HumInt  DewPtint  Temp Ext HumExt  DewPtExt *
30.72 4% 458 ¢ 2313C 3047 % 4830
30.72% 453C 2311¢C 3045 % 481C
3073% 460C 2313C 3035 % 477C
30.82% 485C 2316C 3046 % 484C
30.88% 467C 23.16C 3038 % 481C
30.82% 485C 2313¢C 3041 % 480C
3079 % 465C 2313C 3039 % 478 C
3092% 470C 2315C 3040 % 481 C
3082 % 4.66 C 2311¢C 3036 % 476 C
30.88 % 469C 2315C 3047 % 4.84C
3097 % 476 C 2315C 3042 % 482C
3093 % 472C 2316C 3043 % 483 C
3091 % 470C 2316C 3047 % 4.85C
30.84 % 4.68C 2315C 3042 % 482C
30.94 % 472C 2315C 3047 % 484C
30.87 % 4a7nc 2316C 3037 % 480 C
3091 % 473C 2316C 30.44 % 484C
30.87% 471 C 2317¢C 3043 % 484C
3093% 473C 2317¢C 3041 % 484C
3093 % 475C 2320C 3041 % 486 C
3086 % 468C 2318¢C 3037 % 483C
3091 % 473C 2318¢C 30.34 % 481C
3091 % 474C 2318C 3038 % 4.83C
3093% 476 C 23.16C 3041 % 4.82C
3093% 476 C 23.16C 3043 % 4.83C
3099 % 479C 2317¢C 30.55 % 480 C
3095 % 478C 2318C 30.38 % 483 C
30.88 % 473C 2318C 30.38 % 483 C
30.88 % 473C 23.20C 3031 % 481C
30.85% 47mc 23.20C 3031 % 481C
30.87 % 475C 2320C 30.18 % 475C
30.81% 472C 2317C 30.25 % 476 C
30.84% 473C 2320C 30.13 % 47c
30.72% 467C 2318C 30.14 % 47mCc
30.80 % 472C 2317¢C 30.14 % 47 c
3076 % 469C 2318¢C 30,13 % 471 C
3087 % 475C 2318¢C 30.28 % 478C
3083 % 4720C 23.16C 30,18 % 472C
3083 % 473C 2318C 30.23 % 476 C

41.27 % 9.01C nan nan nan v

Figure 11: Downloading with an External Sensor

= CVSfiles and Excel files will contain both sets of data.

= PDF reports are of the external data.

= The PC application graph can show internal data by clicking on the "Internal" checkbox and then “Read”. To
show the external data click on the "External” checkbox and then “Read”.
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4.10. Text Size

It is possible to change the application text size by
selecting from the Text pulldown on the program header.
The Auto setting selects one of the sizes based on
screen resolution. When the application reopens, text
size is remembered.

4.11. Language

The GUI application comes with language translation.
Today one can select between English, German and
Danish from the Language pulldown on the program
header. Future versions will support more languages.
When the application re-opens, language preference is
kept.

5. BATTERY REPLACEMENT

The Minnow 2.0 logger runs from two standard coin cell
batteries. We recommend a CR2032 240mAH coin cell
battery. There are different manufacturers but a good
one is Panasonic CR-2032.
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Figure 12: Altering Text Size

m Senonics PC Application (1.2.3)
File View Export Options Language Text Help

— Danish sh int |
% - ﬂ il ow internal sensor or
= X g E German r external sensor data
®  English

Logger Minnow 2.0TH [ Temperature & Humidity)
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Figure 13: Language Preference

First remove the Minnow cover by unscrewing the four
fastener screws (#1 Philips) at the rear of the logger.

Insert two new batteries as shown being careful not to
touch any exposed electronics in the process. Be careful
also to connect the batteries in the correct orientation.

Finally re-attach the cover and tighten the fastener
screws again (be careful not to over tighten).
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